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Style conventions used in this document:

Ul Text: Text that represents elements of the Ul such as button names, menu
options etc. is presented with a grey background and border, in
Tahoma font which is traditionally used in Windows Uls. For example:

Ok

Standard Terms (Jargon): Text that is not English Language but instead refers to
industry standard concepts such as Strategy, BACnet, or Analog Input
is represents in slightly condensed font. For example:

BACnet

Code:  Textthat represents File paths, Code snippets or text file configuration
settings is presented in fixed-width font, with a grey background and
border. For example:

$config file = c:\CYLON\settings\config.txt

Parameter values: Text that represents values to be entered into Ul fields or
displayed in dialogs is represented in fixed-width font with a shaded
background. For example

10°C

Product Names: Text that represents a product name is represented in bold
colored text. For example

INTEGRA™

PC Keyboard keys: Text representing an instruction to press a particular key on
the keyboard is enclosed in square brackets and in bold font. For
example:

[CtrI]+[1]
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The Unitron and Cylon BACnet Building Management Systems are made up of two main types of component:

e Hardware - the products that monitor and control a building's environment.

e Software - the interface which allows users to configure and monitor Cylon Hardware.

HARDWARE COMPONENTS

Unitron and Cylon BACnet use the following main hardware components:
e Communications Controllers.
e |/O Field Controllers.
e Keypad
e PC

There may also be other supplementary hardware components such as printers, modems, pagers etc., but these
are not essential to the basic system.

Communications Controllers

The UC32.netK, UCC4 and UCC4.net are programmable communications controllers, which network 1/0 controllers
together. They also handle global time schedules (see page 384) for the 1/0 Controllers connected to them.

Communications controllers ("Comms Controllers") can be connected together and, communicate with each other
in a peer-to-peer arrangement. For UC32.netKs this connection is over fast Ethernet (100Mbps Full Duplex by
default), and for UCC4s and UCC4.nets it is by ARCnet.

Comms Controllers also deal with Alarm handling and other network functions.

A Comms Controller can be linked directly to a PC, a modem or a printer.

1/0 Field Controllers

UC32.xx, UCxxPG-R, UCUxx, UCxx, CBM and CBT controllers take inputs from sensors and Building Control plant,
and send output to Building Control plant in response. They are available as programmable or unitary controllers,
with various input/output configurations.

These 1/O controllers can be programmed with strategies, which configure them to send specific outputs to
connected devices in response to events occurring on their inputs. For example, you can create a Strategy in the
Engineering Centre and download it to a Field Controller specifying that a valve be opened if the temperature
being input to the controller rises above a predetermined level.

Cylon Field controllers are networked together using RS485 by Communications Controllers, which in turn are
networked by Ethernet (or ARCnet in legacy systems). A Field controller can also be linked directly to a PC, as well
as to a modem or a printer.

18
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PC

The PC is connected to a Cylon network by Ethernet, RS232 or modem connection. The PC can also be connected
directly to an I/O controller for small installations with stand-alone controllers.

wasAs JuswaSeue|n Sulpjing

The Cylon Engineering Centre software - which is used to configure the controllers, schedule events and extract
reports - is run on the PC. Since the Cylon software is Windows-based, the PC must have Windows 2000 or
WindowsXP installed and running.

The minimum specification for a PC that will be used to run the Command Centre and Engineering Centre is as

follows:
Minimum PC Intel Core 2 Duo E6300 processor, 1Gb RAM, 80Gb hard disk
Recommended PC Intel Core 2 Duo E6600 processor, 2Gb RAM, 160Gb hard disk
Operating System Microsoft WindowsXP Professional 32 bit, Microsoft Windows7

Professional 32 bit

Connections between hardware components
The following types of connections exist between the hardware components:

e  Fast Ethernet bus connecting UC32.net Communications Controllers and CBR routers.

e An ARCnet network, connecting UCC4 Communications Controllers in a bus configuration (could also be
star configuration if co-axial ARCnet is used).

e An RS485 fieldbus, using shielded twisted pair cables, connecting the Communications Controllers to the
I/O controllers.

e An RS232 connection between the PC and a Comms Controller.

There may also be other connections between Comms Controllers and printers, modems, pagers, etc. but these
are not essential to the basic system.

MANOO058 rev 78 © Cylon Controls 19



SOFTWARE COMPONENTS

The Cylon suite of software applications is used to set up, maintain and control the Cylon system in operation. The
individual applications ("modules") within the suite are grouped into the Unitron Command Centre (also referred
to as "the Command Centre" ) and the Cylon Engineering Centre (also referred to as "the Engineering Centre") as
shown below. Each of these modules can be started from the Command Centre and Engineering Centre groups in
the Windows Start menu.
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Engineering Centre modules
The following applications are available from the Engineering Centre group in the Windows Start menu :

e Database Interface

e Database Server

e Documentor

e  Parallel Keypad Compiler
e Serial Keypad Compiler

e  Serial Keypad Wizard

e Modem

e Schedule Planner

e Sijte Organiser

e Engineering Centre

e UC16 Modem/CCDial/Modem Interface
e  UCC4 Configuration

e  Site Backup Utility

e Configuration

Command Centre Modules

The following applications are available from the Command Centre group in the Windows Start menu :

e Alarm Handler

e CCDraw

e (CCView

e Database Interface
e Database Server

e Datalog Manager

e Modem
e Pager
e Reports

e Schedule Planner

e Time Schedule Manager

e UC16 Modem/CCDial/Modem Interface
e  Site Backup Utility

e Configuration

20 © Cylon Controls MANOO58 rev 78



Each of the Cylon Software modules is explained in detail below:

g Configuration

The Configuration program contains a blueprint of the system, which can be accessed by other programs as
required. It is used to define systems, networks, sites, authorised users, modem protocols, port setups, etc. and to
activate alarms. Levels of access for different users can also be defined here. (See also MAN-0041 Configuration
User manual.)

Em Alarm Handler

The Alarm Handler program is used to alert you to any alarm conditions within the system. The alarms can be
enabled, disabled or filtered in the Configuration program. When they have been enabled, the Alarm handler will
run automatically every time the Command Centre is run. If alarms are enabled, and alarm modules are included
in Field Controller strategies, any alarm event will be sent to the Alarm handler (also known as the Alarms program)
and displayed on the screen. (See also MAN-0047 Alarm Handler User Manual.)

/3;1% CCDraw

CCDraw is a graphics application, which allows you to create dynamic graphic windows to use with the CCView
program. These are pictures of the site, through which, in CCView, you can travel around the site, viewing and
altering conditions as necessary. (See also MAN-0040 CCDraw User manual).

@ CCView

CCView contains the Command Centre from which you can communicate with the controllers. By opening up the
dynamic pictures created in CCDraw, you can travel through a site, viewing and altering conditions as necessary.
Reports can be obtained from dynamic points created in CCDraw, and appliances can be adjusted, or switched on
or off. (See also MAN-0039 CCView User manual.)

g Database Interface

The Database Interface program allows you access to the database that contains details of all the point values on
each Field Controller in the network. You can set point values graphically in the Engineering Centre, or you can
enter or delete them in the Database Interface program.

Database Server

The Database Server is the database where details of all the point values on each Field Controller in the network
are kept. You cannot access the Database Server directly. The Database Interface program allows you to edit point
descriptions and engineering units in the database manually, and the Engineering Centre allows you to edit point
values in the database graphically.

Serial Keypad Wizard

The Serial Keypad Wizard allows you to create keypad programs for use with the UC32. (See also MAN-0055
Engineering Centre Keypad Wizard manual.

MANOOQ58 rev 78 © Cylon Controls 21
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Goun  Parallel Keypad Compiler

The Parallel Keypad Compiler program allows you to create programs for use with the UCC4 or Field Controller
keypad. You can then download these programs to the keypad. (See also MAN-0023 UCC4 Keypad User's Guide
and MAN-0023 UC16 Keypad User's Guide.)

% Documentor

The Documentor is a Microsoft Excel macro package, and requires Microsoft Excel to be installed on the PC for it
to work. When the Documentor is run, it extracts a record of the configuration of the network. These are printed
out when required (for example, as a daily report of the state of the site). Information about specific parts of the
network can also be accessed. The Documentor is not automatically loaded when the system is started up. You
must run it when it is required. (See also MAN-0019 Documentor manual.

[ — | . .
««o Serial Keypad Compiler

The Serial Keypad Compiler program allows you to create programs for use with the UCKRA420 Serial Text keypad.
You can then download these programs to the Comms Controller or Field Controller that the keypad is connected
to. The Compiler can create programs for UC32.net Communications Controller, UC32 and UCxx Field controllers,
and UCC4 v3.8.0 or earlier Communications controllers. (See also MAN-0004 Serial Text Keypad and Compiler
manual)

@' Datalog Manager

A datalog is set-up in the Engineering Centre, and logs the value of a specified point in a Field Controller at a
specified interval, over a period of time. So a datalog contains a record of the changes in a point value over a period
of time. The Datalog Manager program allows you to display the contents of a datalog in either graphic or tabular
form. (see also MAN-0043 Datalog Manager User's Guide)

% Modem

The Modem program allows you to view the present state of any modem connected to the network (i.e. it allows
you to see whether the modem is off-line, transmitting, starting up, etc.). Provided there is a modem in the Cylon
system, the Modem program is run automatically when the Command or Engineering Centre is started up.

AT
|:| s

=== Pager

The Pager program acts as an interface between various paging services and the Command Centre. It can accept
alarms sent from the Alarm handler and transmit them automatically to an engineer’s pager using the pager
service. (See also MAN-0021 Pager manual.)

Reports

The Reports program allows you to collate information from the network for permanent storage. Reports can be
produced manually or automatically and saved to a file from which they can be printed out. Automatic reports can
be produced at regular intervals — hourly, daily, weekly, monthly, etc. The PC must be switched on permanently if
the reports program is to run correctly. (See also MAN-0044 Reports Module User Guide.)
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Schedule Planner

The Schedule program defines the schedules for a site configured in the Configuration module and set-up in the
Engineering Centre. Standard time schedules can be assigned for normal working days and weekends. Exceptions
can be set-up, e.g. for holiday periods. These schedules are then downloaded to the Comms Controller and
distributed throughout the network by the use of globals. (See also MAN-0054 Schedule Planner User Manual.)

Time Schedule Manager

The Time Schedule Manager allows the creation of multiple time schedules in the supervisory PC, which can be
downloaded simultaneously to several Comms Controllers. Logical groups of Comms Controllers can be defined,
to which the Time Schedules can be sent, and these are called “Site Groups”

Time Schedules can be downloaded manually when needed, or can be downloaded automatically by the Report
module. The original settings for each schedule can be re-loaded on the site's controllers at any time by using the
Schedule Planner. (See also MAN-0035 Time Schedule manager Manual)

A Site Organiser

The Site Organiser is an easy way to configure and examine a complete site or part of a site. Instead of downloading

strategies individually to all the controllers on a site, this can be done in one simple task. Any combination of

strategies can be downloaded to any combination of controllers or to one type of controller in a .ins batch file.
(See also MAN-0020 Site Organiser manual.)

Engineering Centre

The Engineering Centre is a graphical interface created for programming the Cylon range of universal controllers.
In the Engineering Centre, strategies (which tell a controller how its outputs should respond to conditions on its
inputs) can be designed, edited and downloaded to, or uploaded from, Field Controllers. Globals can also be
assigned to Comms Controllers to pass values to other controllers on the network. The Engineering Centre could
be described as the most important of all the Cylon applications, as it is the application that programs the Cylon
controllers. This manual describes how to carry out a variety of tasks in the Engineering Centre.

% Modem Interface

The Modem Interface program allows for communication between a controller and a remote supervisory PC, via
modems. In addition to the long-established feature of the Modem Program, which allows strategies on a remote
site to be examined by dialling the remote site from the PC, the Modem Interface program now allows Field
Controllers to dial-out to a supervisory PC, e.g. in the event of an alarm.

F
UCC4 Configuration

The UCC4 Configuration program is used to configure the ports on UCC4-type Comms Controllers for
communication with peripheral devices such as printers or modems. (See also MAN-0053 UCC4 Configuration User
Manual.)
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@ Site Backup Utility

The Site Backup Utility automates the process of backing up a site, and can be used to move sites from one PC to
another, for synchronizing files (if several people are working on a single site on a number of different PCs), or for
making security copies of a Site’s files. (See also MAN-0038 Site Backup Utility User Guide)
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THE ENGINEERING CENTRE — OVERVIEW

The Engineering Centre is the application that is used to program the Cylon controllers and is therefore the key
application of the Cylon Software suite. The Cylon Engineering Centre provides all of the tools required to design,
configure, test, commission and maintain Cylon BACnet, UnitronUC32 and Unitron2000 systems automatically.
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The Engineering Centre switches between BACnet, UC32 and Unitron2000 modes depending on which type of
controller is selected in the Site Tree .

You can use the Engineering Centre to:

Graphically create strategies that implement solutions to conditions on site.
Save those strategies for future editing, testing or reference.

Test the operation of strategies.

Debug and edit strategies.

Download strategies to the appropriate controllers.

Define and assign local globals to carry data across a Fieldbus.

Define and assign wide globals to carry data between Fieldbusses and across the network of a site.
Upload existing strategies from controllers.

Upload analog and digital point values from controllers.

Upload globals from controllers and from networks.

Upload statistical and reference information from controllers.

Record changes that occur on a site as they happen and save the record to a file.
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PARTS OF THE ENGINEERING CENTRE

The main Engineering Centre interface is illustrated below:

'r'fu Engineerning Tool - Beta 2 - Strategy 1
File Edit “iew Macro Communication: UC UCC4  Digplay  Livelog ‘wWindow Help

D2E| =B g agqm P LM I: F S | & g

Analog  Analog  Digital  Digital Analog Dlgltal Real Integer  Dig-Ext. -Enc.  Diigital Plake I
Input Output  Input  Cukput St Fat '39"'*'5?"'"5 Canstant  Linear E

+EI I:'_::’_ |;‘lllo:“;| |u"n | _'a 143 *'H?' D-}a m

-8 Office Block —
=B85 Local Metwark
=-# First UCC4
= Fist UC1E
@ Second UCTE

007 ocal netark 007 -first ucc4 |01 first w16 L

Page: 1 L

THE TITLE BAR

The title bar contains the name of the application, followed by the name of the active file, i.e. the strategy file that
is currently in use. In the example below, the strategy file AHU1.stg is active.

'fr._':'_u Engineering Tool - AHU1 .stg

Cil- CAHF e kd—mre Mararcammim=bimess LI 1IETA LI e B e L LTS TR I P P

THE MENU BAR

The menu bar contains 12 menus listing the commands necessary for designing and implementing strategies.
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The File menu

New
Open
Close
Save
Save As

Save All

Sign On

Sign Off
Login

Logout
Global Editor
Footers

Print

Print Preview
Print Setup...

Printer Scaling...

Exit

Creates a new strategy.

Opens an existing strategy.

Closes the active strategy.

Saves the active strategy under its current name.

Saves the active strategy under a new name or saves a strategy for the first time.

Saves all the open strategies under their current names
(If there are any unnamed strategies open, the Save As dialog box will appear to allow
you to save them under a particular name).

Signs On to the Engineering Centre

Signs Off from the Engineering Centre

Logs in to the target controller.

Logs out of the target controller.

Shows all of the globals in a site, and allows them to be edited.
Edits the footer that appears with the strategy when it is printed.
Prints the current strategy.

Shows the strategy as it will appear when printed.

Edits details relating to the printing of the strategy.

Allows the size of the printed strategy to be adjusted.

Switches from the active strategy to one of the four most recently used strategies.

Closes the Engineering Centre.
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The Edit menu

Cut Cuts a selected item or items from the active strategy and place it on the Clipboard.

Copy Copies selected items from the active strategy, and places it on the Clipboard.
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Places the contents of the Clipboard onto the drawing area

Paste > o .
(by clicking the mouse over the required inset point).
Select All Selects all of the items in the current strategy drawing
Add Text Inserts text into the strategy.
Find Opens the Find dialog, to locate or step through Points, Modules Macros or Globals in the
currently-opened strategy.
Find Next Steps to the next item in the strategy that matches the settings in the Find dialog.
Find Previous Steps to the previous item in the strategy that matches the settings in the Find dialog.
Add Comment Block Allows a comment block to be added to the strategy.
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The View menu

View

Toolbar

Status Bar
Current Target
Macro Bar

Site List

Modules

Globals

Virtuals

Managers

Zoom In
Zoom Out
Zoom to 100%

Zoom Level...

View

Toolbar
Status Bar

Current Target

Displays or hides the Toolbar.

Displays or hides the Status bar.

Displays or hides the Current Target bar.

Displays or hides the Macro bar.

Displays or hides the Site List.

Selects one of the six module bars (see below).

Selects a global from the Globals bar or adds a global.

Displays or hides the virtual modules bar.

Displays details about current resource availability.
Information about Globals, Strategy Blocks, the controller, inputs and outputs is

provided.

Zoom in - Enlarges the current view of the strategy

Zoom out - Reduces the current view of the strategy

Returns the strategy view to actual size.

Allows the zoom level to be specified by number.

Macro Bar

Site List

Modules P Points

>

Globals L Logic

Virtuals M Mathematical
Managers C Control
Zoom In F Function
Zoom Out S Static

Zoom to 100%

Zoom Level...

Displays the Points module bar

Displays the Logic module bar

Displays the Mathematical module bar
Displays the Control module bar

Displays the Functions module bar

Displays the Statistics module bar

The Macro menu

Macro

Create

Manager

Creates a macro using selected modules on the drawing area.

Adds or edits macro group details.
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The Communications menu

Communications

Communication Setup I Configures the download and scan global set-ups.

Upload Uploads the strategy from the controller to the PC.

Download Downloads the strategy from the PC to the controller.

Scan Examines the strategy’s points in the controller and displays their values in
real-time.

Change Point Value Changes the value of a setpoint in a controller.

Change Controller Address Changes the address of the currently targeted controller.

Change UCU Baud Rate Changes the baud rate of the targeted controller, if it is a UCU type controller.

Configure BACnet Device Allows BACnet device properties to be set.

Note: Scan option is only available when the PC is logged in to the Cylon network, and when Display
points has been checked in the Module Setup dialog box.

Change UCU Baud Rate is only available if the targeted controller is a UCU.
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The UC32 and UC menus

If the target of a strategy is a UC32-type controller, the UC32 menu is visible in the Engineering Centre's menu bar:

UC32

Version

Setup

Time and Date

Wipe Controller

Statistics
Strategy Lock/Unlock
Keypad

Configuration Info

Diagnostics

Terminal Setup

UC32

Version
Setup
Time and Date

Wipe Controller

Statistics

Strategy Lock/Unlock

Keypad

Gets the version of the targeted UC32 controller.

Sends the setup to the controller and displays the current setup of the
controller.

Sends the time and date to or uploads it from the controller.

Clears the memory of the targeted UC32 controller.

Get details of the engineering, system and alarm statistics for the controller.
Allows you to password-protect (lock) a strategy, or access a locked strategy.
Allows you to create and download keypad programs.

Opens a display panel showing the configuration of the UC32's hardware.

Displays board diagnostic information.

Opens the Terminal Settings panel.

Configuration Info

Diagnostics

Create & Download Keypad

Download Keypad

Configure Keypad

Terminal Setup

Clear Keypad Info...

Opens the Keypad Wizard as 'Standalone’
Sends a saved Keypad program to the UC32

Allows the operating parameters of the keypad
program and the keypad hardware to be set.

Deletes Keypad information from the Cylon

Software database

If the target of a strategy is a UC or UCU-type controller, the UC32 menu is replaced with the following UC menu:

uc

Version

Setup

Statistics

Time and Date
Configuration Information

Wipe UC Memory

DI Setup

Gets the version of the targeted controller.

Sends set-up to the controller and displays the current set-up of the controller.
Gets details of the engineering, system and alarm statistics for the controller.
Sends the time and date to or uploads it from the controller.

Displays information (e.g. max. address) about the targeted controller.

Clears the memory of the targeted controller.

Allows the inputs on a UC16DI controller to be configured.

Note: DI setup option is only available when the PC is logged in to the Cylon network, and when the
target of the open strategy is a UC16DI.
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The UC32.net and UCC4 menus

If the target of a strategy is on the Fieldbus of a UC32.net Communications Controller, the UC32.net menu is visible

in the Engineering Centre menu bar:

UC32.net

Version & Identification ...
Setup ...
Time and Date ...

Wipe Memory ...

Port Setup ...

Alarm Setup ...
Keypad

Web Server Access ...
Strings...

Send Site Number ...

Generate Report ...

Gets the version of the UC32.net to which the targeted controller is attached.
Sends setup to the UC32.net and displays its current setup.
Sends the time and date to or upload it from the UC32.net.

Clears selected parts of the memory of the UC32.net to which the targeted
controller is attached.

Allows each of the UC32.net's ports to be configured

Defines which alarm priorities will be scanned by multiple supervisor PCs.
Opens the Keypad sub-menu (see below)

Enables Web access, and defines its security settings

Defines Alarm, Modem, and Print strings in the UC32.net

Sets the site number in the UC32.net

Generates a report of the UC32.net's operating statistics

UC32.net

Version and

Setup

Time and De

Wipe Memot

Port Setup

Alarm Setup

Keypad »| Keypad Configuration ... Enables the 'configuration program' in the
UC32.net's keypad, and sets the password

\Web Server| Create & Download Local UC32.net Keypad Program Opens the Keypad Wizard as 'Local'

Strings... Create & Download Wide UC32.net Keypad Program Opens the Keypad Wizard as 'Wide'

Send Site N| Download Keypad Program... Sends a saved Keypad program to the
UC32.net

Generate Re

If the target of a strategy is on the Fieldbus of a UCC4 or UCC4.net Communications Controller, the UC32.net menu

is replaced by the UCC4 menu:

UCC4

Version

Setup
Statistics

Time and Date

Wipe Memory

Remove Time Schedules

Gets the version of the UCC4 to which the targeted controller is attached.
Sends set-up to the UCC4 and displays its current set-up.

Gets details of the engineering, system and ARCnet statistics for the UCC4.
Sends the time and date to or upload it from the UCC4.

Clears the memory of the UCC4 to which the targeted controller is attached.

Deletes UCC4 Time Schedule from the Cylon database.

If the target of a strategy is on a BACnet Site, neither the UCC4 nor UC32.net menus will be displayed.
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The Display menu
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Display

Windows Setup Define the style of background desired.

Colours Choose the colours for the background and grid (see below).

Module Setup Choose whether point values and constant values of modules are displayed during
scanning, whether lines and point numbers joining modules are displayed, and
controls routing of joined points (illustrating all connections to a selected point).

Display

Windows Setup

Colours Grid Choose colour for the Grid

»
Module Setup Background Choose colour for the Background

The LiveLog menu

LiveLog
Setup Determine how and what the LivelLog is to scan, i.e. all open strategies or active
strategy only, interval between scans, and whether to log scan results to a text file.

Log Scan the strategy’s point values and time schedules.

View Reads the results of all previous scans logged to a text file (See Setup above).
The Window Menu

Window

Cascade Arrange the strategy windows diagonally across the Engineering Centre window.

Tile Horizontal Arrange the strategy windows horizontally.

Tile Vertical Arrange the strategy windows vertically.

1. View the names of all open strategies.

The Help Menu

Help
Help Use on-line help.
About Cylon Engineering Centre... Get details of the application version number, copyright etc.
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MENU OPTIONS AVAILABLE ONLY WHEN LOGGED IN

The menu options listed below require the PC to communicate directly with the controller and so are only available
when you are logged in: (To log in click the login/logout button on the toolbar or choose Login from the File menu)
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e  Upload (Communications menu )

e Download (Communications menu)

e Scan (Communications menu)

e Change point Value (Communications menu)

e Change Controller Address (Communications menu)

e  Change Baud Rate (Communications menu)

e Version (UC32 and UC menus)

e  Statistics (UC32 and UC menus)

e  Strategy Lock/Unlock (UC32 menus)

e Time and Date (UC32 and UC menus)

e  Wipe Controller Memory (UC32 and UC menus)
e  Configuration Information (UC32 and UC menus)
e Diagnostics (UC32 menu)

e DI Setup (UC menu)

e Version & Identification (UC32.net and UCC4 menus)
e  Statistics (UCC4 menu)

e  Setup (UC32.net menu)

e Time and Date (UC32.net and UCC4 menus)
e  Wipe Memory (UC32.net and UCC4 menus)
e  Port Setup (UC32.net menu)

e Alarm Setup (UC32.net menu)

e  Web Server Access (UC32.net menu)

e Strings (UC32.net menu)

e Send Site Number (UC32.net menu)

e  Generate Report (UC32.net menu)
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THE TOOLBAR

The toolbar contains a number of buttons, which can be used as alternatives to menu options.
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